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DigiEffects is proud to introduce Web Euphoria for Photoshop 
Macintosh!  These plugins are new to this environment, and have 
been proven useful by video professionals the world over.  All 20 
originated in the various DigiEffects plug-in sets: Aurorix 2, Berserk, 
Cinemotion, and Delirium for Adobe After Effects and other hosts.

Many of our After Effects users are Photoshop users. The idea 
had been posed as a 'what-if' and a 'wouldn't-it-be-nice' sort of 
suggestion many times since the effects were introduced.  So we 
thought it would be useful to bring these same dynamic effects to 
the high-res, photographic environment of Photoshop for use on the 
Web and in digital design.

Never before have digital artists been given this level of creative 
control over images! Web Euphoria contains 20 special effects plug-
ins for Photoshop, includes tools for creating artistic effect as 
well as naturalistic phenomenon with particle-based fire, smoke 
and rain. These aren’t your typical “particle-only” simulations, 
these effects are enhanced with built-in organic processing to 
create highly realistic simulations without resorting to complex 3D 
programs.

You can also create old-movie effects, noisy video transmissions, 
light-blasts, posterizations, laser beams, text effects, and much 
more! Each plug-in has a custom user interface that is easy to 
use. There are many presets, and you can even save your own. 
Fully interactive preview allows changes to be made quickly. Web 
Euphoria may be used with Premiere, but the parameters and 
effects are not animatable. If you require animated versions, please 
look into our After Effects packages.

INTRODUCTION
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HOST APPLICATION
Web Euphoria was design with Photoshop in mind, but it will work 
with many applications that accept Photoshop plug-ins. Here is a 
partial list of compatible hosts:

Photoshop (MacOS)- Plug-ins perform correctly in Photoshop 2.5, 3, 
4, 5, and 6 under Mac System 7, 8, and 9.

ImageReady (MacOS) All plug-ins work correctly under Mac System 
8.x, and 9. 

Director (MacOS) All plug-ins work correctly under Mac System 8.x, 
and 9. 

Canvas (MacOS)- All plug-ins work correctly. Set preferences to 
direct Canvas to the Photoshop directory where your filters are 
stored (like Photoshop, the program correctly searches for plug-ins 
in subfolders/subdirectories and shows them in a hierarchical 
menu). Execution speed of some plug-ins is slower than in 
Photoshop, possibly due to disk caching differences.

DeBabelizer (MacOS)- All plug-ins work correctly. Set preferences 
to the folder/directory in which the Photoshop filters are stored. 
Sub-folders/sub-directories are NOT searched for plug-ins, but Mac 
aliases are followed. The menu lists plug-ins alphabetically under 
“Other.”

CorelDraw & Painter (MacOS)- A user has reported that the Tool Kit 
plug-ins do not work in older versions of these programs, although 
some other Photoshop plug-ins do function. We have no test data 

SYSTEM REQUIREMENTS
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on the most recent versions of either program, both of which claim 
to fully support Photoshop plug-ins and therefore should function 
with the plug-ins. 

PhotoDeluxe (Mac)- All plug-ins work correctly under Mac System 
7.x, 8.x, and 9. Because all images are treated as color, multilayer 
arrays the plug-ins operate more slowly than in Photoshop.

IMPORTANT INFORMATION 
THAT WILL SAVE YOU SEVERAL HEADACHES

MEMORY REQUIREMENTS
All of Web Euphoria's effects must render within the RAM space 
of Photoshop and are intended for web-sized and digital camera 
images. Some effects require 2-3 times the amount of RAM used by 
the layer that the effect is being applied to. 

If you have low memory error messages, please increase the 
memory partition for Photoshop by 5,000K each time you receive 
out of memory messages. The recommended partition size for 
Photoshop is 64mb (64,000K) for web-based images. We recommend 
at least 256mb (256,000K) for print documents, but this may not 
be enough for some documents. You will need to quit Photoshop to 
change this setting.

Most effects are limited to use on images that are less than 2000 x 
2000 pixels. Most of the images on the internet are much smaller 
than that. If your document is larger, apply the effect to a smaller 
section that is less than 2000 x 2000 in pixels using the selection 
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tools.

Use the “Piggy Plug-ins Patch” if you keep receiving out-
of-memory messages. The “Piggy Plug-in” will allow more 
memory from Photoshop to be used by the plug-ins. This 
plug-in can be found on the original Photoshop installer 
CD, please do a search. 

Photoshop automatically reserves more than 80% of the memory 
space to itself during start-up. This memory is not available for 
use by the Web Euphoria plug-ins. The "Piggy Plug-in" alleviates this 
problem by allowing a little more memory to be available for use by 
the Web Euphoria plug-ins.

Other host packages handle memory allocation in a more efficient 
manner, so this “piggy” plug-in is not necessary or available in other 
host applications.

Get Info (command-I from Finder)
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INSTALLATION

1 Locate your Photoshop or Photoshop plug-in compatible 
 application directory. Inside that folder there will be a “Plug-
 ins” folder. Open this folder… > Adobe Photoshop > Plug-ins
2  Find the “Install Euphoria” folder on the “Euphoria CD”
3  Find the “Euphoria Installer” program inside that folder. 
 Double click it.
4  Follow the instructions in the installer. Install the plug-ins in 
 this folder… > Adobe Photoshop > Plug-ins
5  This will install all the Euphoria plug-ins.
6  If your Photoshop application is running, quit it now and 
 restart the application.
7  You can check proper installation of the plug-ins by doing the 
 following:

Launch your Photoshop application, create a New document, 
click on the Filters menu, you should see the “DigiEffects 
Euphoria” sub-menu, select it and check to see if there are 
any plug-ins in the menu.  If you do not see any plug-ins, see 
the next section, “Problems with Installation”

NOTE: The most recent version of the manual is on the CD-ROM that 
came with Web Euphoria. Please check it if you are having problems 
that are not addressed in this manual.

INSTALLATION
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PROBLEMS WITH INSTALLATION

The most common problem with installation is that the plug-ins do 
not show up.  First, be sure that the plug-ins are indeed in your 
“plug-ins” folder.  If they are and still don't appear, it is because 
Photoshop does not always check to see if there are new plug-ins in 
the “Plug-ins” folder every time Photoshop is launched. This is done  
to make launching Photoshop faster.  To fix this you need to force 
Photoshop to look at the plug-ins folder for new plug-ins.  To do 
this, you need to tell Photoshop the plug-ins folder is in a different 
place, then switch it back.  The instructions seem a bit crazy, but 
this is the way it goes until Adobe fixes the problem.

1 Launch Photoshop.
2 Open the File Menu > Preferences > Plug-ins dialog.
3 Set the plug-ins folder to any other folder outside the 
 Photoshop folder. 
 IMPORTANT: Do NOT choose a folder inside the Photoshop 
 folder. Click OK.
4 Quit Photoshop and then immediately Launch Photoshop 
 again.
5 Open the File Menu > Preferences > Plug-ins dialog.
6 Set the plug-ins folder back to the normal plug-ins folder, 
 which is usually in the same folder as Photoshop.
7 Quit Photoshop, and then Launch Photoshop again. The plug-
 ins should now appear.
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This tutorial will explain how to apply a Web Euphoria effect within 
Photoshop. Your application may differ slightly but the overall 
concepts will be the same.

Applying Effects Basics

1 Launch Photoshop & Open the "Astronaut.jpg" image.
2 Select the menu "Filters" -> "DigiEffects Web Euphoria" -> 
   "Sabbatier"
3 Adjust the "Rotate" and "Contrast" parameters to
   alter the image.
4 Click the "Zoom" icons (small and large mountains)
   to magnify the image. By zooming out, the effect will
   render much faster, making experimentation easier.
5 Click on the "Preset +" button to save a preset.
6 Call the preset "Test" and click "Save".
7 Click "OK" to apply the effect to the Astronaut image.

Text Effects Basics

1 Launch Photoshop & Open the "Astronaut.jpg" image.
2 Click on the "Text" tool, and create a block of text that
   reads "Euphoria", 36 point type.
3 Rasterize the type (which turns the vector-font into 
   pixels) by selecting "Layer"->"Rasterize"->"Type"
   NOTE  This command may be different in your version 
   of Photoshop.
4 Apply the Fire filter by selecting "Filter"->"DigiEffects Web
   Euphoria"->"Fire"

TUTORIAL
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5 Set the "Generate Mode" to "Generate Layer Alpha >
    Threshold". This tells the Fire plug-in to generate particles
     only where the Alpha (transparency) exceeds a certain
    value determined by the "Generate Threshold" control.
6 Set "Turbulence" to 1. This decreases the wispiness and 
   makes rendering faster.
7 Set "Turbulence Size" to 10. This will make the wisp 
   area more compact.
8 Set "Min Size" to 40, and "Max Size" to 150. This adjusts the
   size of the individual fire particles. This will increase detail.
9 Adjust the "Random Seed" to 11. You may want to check other
   values to see what looks best.
10 Turn up the "Min Opacity" to make the fire effect more intense.
11 To create more flames, let's increase the "Fire Generate" to
   160. This will create more fire particles.
12 Change the "Source Alpha Mode" to "Effect Behind" to place
   the flames behind the text.
13 Adjust the "Alpha Threshold" to 150 which will remove the
   darker areas of the flames, making them more transparent.
14 Since it is more transparent, let's increase the amount of 
   flames by moving forward in "Time" to 30.
15 Still not enough, so let's add more particles by setting
   the "Fire Generate" to 200.
16 Let's save it as a preset, "Tutorial Fire" by clicking on the 
  "Preset +"
17 This looks good, so let's apply it to the layer by
   clicking "OK".
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Advanced Text Effects

1 Launch Photoshop & Open the "Astronaut.jpg" image.
2 Click on the "Text" tool, and create a block of text that
   reads "SnowFall", 96 point type. Place the text towards
   the bottom of the screen.
3 Rasterize the type (which turns the vector-font into 
   pixels) by selecting menu "Layer"->"Rasterize"->"Type"

 NOTE This command may be different in your version 
  of Photoshop.

4 Apply the Fire filter by selecting "Filter"->"DigiEffects Web
   Euphoria"->"Snow Storm"
5 Zoom out to 50% for a faster preview.
6 Change the "Pileup Mode" to "Pile on Alpha > Threshold
   via 2D". This will cause the SnowStorm plug-in to 
   begin doing collision detection with the alpha channel
   of the text block and the particles of snow. You should
   now be able to see the snow flakes landing on the 
   text block.
7 Increase the "Snow Amount" to 100. This will cause the
 snow to increase in volume.
8 The edges of the flakes are rather dark, so increase the
   "Alpha Threshold" to 50 and decrease the "Alpha Weight"
   to 128. This will make the dark areas of the particle less
   intense.
9 Zoom to 100% to see the effect. Use the "Hand" to pan
   around the image.
10 The snow should be very apparent now. Save this preset

TUTORIAL
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   as "Snow Tutorial" by clicking the "Preset +" button.
11 Click "OK" to apply the effect.

You may want to experiment with different "Apply Modes" and 
transfer modes within Photoshop to composite the effect over the 
image. For example, to completely remove the black areas of the 
snow, do the following:

Post-Compositing Effects with Photoshop

1 Create a text layer, duplicate it, and render one of the 
   layers. You will have 2 identical layers, one rendered 
   and one with active text. We will now apply 
   Snow Storm with "effect only" so we can use the 
   Photoshop tools to perform the compositing of the 
   effect over the text.
2 Apply and Adjust the effect as in the previous tutorial.
   Steps 4 through 8.
3 Before Applying, select the "Source Alpha Mode" 
   "Effect Only". This will apply just the effect and
   will not include the source image.
4 Click "OK" to apply the effect to the source image.
5 Using the Photoshop transfer Mode tools, you can
   composite the effect and text layers and get
   rid of the black areas using "Screen" or "Color Dodge."

This completes the tutorial section. See the web Euphoria CD-ROM 
for the completed tutorial images.
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USING THE 
PLUG-INS
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A Few Words About the Plug-ins
We think it would be helpful to tell you some of the basic ideas 
behind how these plug-ins operate, some specific information about 
how they work and a discussion of some terminology. This section 
is a general explanation of many underlying concepts that drive 
Web Euphoria.

Particle Systems
Web Euphoria has a number of different effect plug-ins including 
a collection of particle systems. Particle systems are a general 
purpose technique to create realistic natural phenomenon and 
artistic effects. 

These particle systems simulate certain specific effects. 
For example, effects like Snow, Rain and Fire are specialized 
particle systems. There are many other effects in Web Euphoria 
that are also based on this particle system idea and therefore the 
discussion of how these particle systems work is also useful for 
these plug-ins.

Most other commercial particle systems are general purpose and 
users have a difficult time creating a desired effect. Web Euphoria 
addresses the root of this problem by creating plug-ins that are 
specific to a certain effect. For example, the Fire plug-in makes 
a great looking fire effect as soon as it’s applied to a layer. In 
contrast, it would be difficult to make snow with the Fire plug-in. 
This is what we mean by "designed for a specific effect."

Web Euphoria delivers a set of particle based effects that are 
designed to handle specific tasks extremely well while continuing to 
be easy to use. It used to be that creating effects like realistic snow 

USING THE PLUG-INS
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with particles that look like snow would take hours to look good.

Control (or Parameter) Naming Conventions
In many cases the controls (also called “parameters”) in Web 
Euphoria are named with terms used in mathematics. We realize 
that this is in many cases not very user friendly, but we also 
recognize that these terms are generally the most accurate and 
applicable across many plug-ins. 

For the sake of consistency we have kept the mathematical terms. 
At the same time, we will use some images to help define some 
of those terms.

Amplitude

Often height could be substituted for Amplitude. Generally, this 
determines how extreme the swings are in the effect. For Visual 
Harmonizer, you can see below what low and high Amplitude will 
create:

   
Amplitude Set to 40   Amplitude Set to 100

But in cases like Camera Shake the effect does not easily translate 
to height. In this case, Amplitude really is more the distance that 
the shake causes the image to travel. So in the case of Camera 
Shake, Amplitude is distance.
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Frequency
Frequency is defined as how often (i.e., how frequent) something 
occurs. In the case of Visual Harmonizer, frequency determines the 
number of waves in each harmonizer.

    
Frequency Set to 5   Frequency Set to 20

In the case of Camera Shake, Shakiness Frequency determines how 
often the camera will shake (i.e., frequency determines when, 
amplitude determines how far). 

Phase
Phase determines where some portion of the effect will occur. The 
easiest way to see this is to look at two examples.

    
Phase set to 35    Phase set to 0

Notice how the position of the wave has moved between the 
two phase values. The position of the wave on the harmonizer is 
determined by Phase.
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Some of the plug-ins have a begin and end value for each of 
these. The plug-in will interpolate between these two values to 
give interesting results. So, by setting all of these parameters 
to different beginning and ending values you can create visually 
stunning imagery.

Channel Operations & Composite Modes

Channel operations are the methods by which two images are mixed 
together. For example, the "Add" operation simply mathematically 
adds the red, green and blue pixel values. The “Composite 
Mode” is the specific channel operation that is used to blend 
(or composite) the effect with the source image. The "Particle 
Composite Mode" handles how the particles that make up the 
effect will blend with EACH OTHER before they are composited with 
the source layer.

Composite modes control how the colors of the Effect interact with 
the colors of the source layer (also called image). There are at most 
two different composite modes that can be used. The first is the 
“Image Composite Mode” which defines how the entire effect will 
be mixed with the entire source image. 

Apply Mode
Use Source
Use source composites the effect over the layer that it is applied.

Effect Only
Effect Only will hide the source image that the plug-in is applied to 
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and show you only the Effect. This is very useful if you want to see 
just what the effect is creating. You can also apply an effect and 
use “Effect Only” to retain the effect’s alpha information for use in 
composition using Photoshop's tools.

Use Source Mode
Effect in Front  
Effect in front places the effect directly in front of the layer to 
which the plug-in is applied.

Effect Behind  
Effect behind places the effect behind the layer to which the effect 
is applied.

TIP This setting is most easily seen when applied to a layer that has 
an alpha channel. The effect will appear from behind the layer.

Composite Effect in Front 
This works exactly like “Effect in Front” except that it enables the 
Composite Mode controls (below). Use this setting when you want 
to use a composite mode other than Blend to composite the effect 
with the source layer. (Like Add or Screen.)

Composite Effect Behind 
Composite Effect Behind composites the Effect with the layer ONLY 
when Subtract and Difference are selected in the Composite Mode 
pop-up. Because of the subtractive nature of those two composite 
modes, the results will be different than the results of “Composite 
Effect in Front.”
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Composite Modes
Composite Mode determines how the effect will combine with the 
source layer. This is similar to the Photoshop “Transfer Modes”, but 
we have built them into the plug-in so that presets can be made 
with specific composite modes.

Add
Add combines the color values of the layers. The resulting color is 
always brighter than the original.

Screen
Screen multiplies the inverse brightness values of the colors in the 
layers. The resulting color is never darker than the original.

Subtract
Subtract uses the effect to reduce the brightness of the source 
layer but does not roll over beyond zero like difference, so the 
extreme colors do not occur. The resulting color is always darker.

Difference
Difference subtracts the color values of the Effect and Source 
Layer displays the absolute value of the result. Colors can look 
psychedelic.

Blend
Performs a simple Blend.

Blend Using Alpha
Blend using Alpha uses the alpha of the effect as a weight to blend 
the effect with the Source Layer.
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Multiply
Multiply mathematically combines the Source Layer and Effect color 
values in the layers and divides the result by 255. The resulting 
color is never brighter than the original.

Lighter
Lighter compares the channel values of the underlying and layer 
colors and displays the lighter of the two.

Darker
Darker compares the channel values of the underlying and layer 
colors and displays the darker of the two.

Scales
This is a special case composite mode to be used on an 
experimental basis. It causes extreme color distortions.

Overlay
This mode will multiply or screen the colors depending on the 
source color. Patterns or colors overlay the existing pixels while 
preserving the highlights and shadows of the base color.

Hard Light
Hard Light multiplies or screens the resulting color depending on 
the source layer color. If the underlying color is lighter than 50% 
gray, the layer lightens as if it were screened. If the underlying 
color is darker than 50% gray, the layer darkens as if it were 
multiplied.

Soft Light



21

Soft light darkens or lightens the resulting colors, depending on 
the layer color. If the underlying color is lighter than 50% gray, the 
layer lightens. If the underlying color is darker than 50% gray, the 
layer darkens.

Minimum
Minimum uses the mathematical minimum of the Effect and Source 
Images color values to replace the original image. This is a modified 
version of Lighter.

Maximum
Maximum uses the mathematical maximum color value to replace 
the original footage. This is a modified version of Darker.

Bit-wise OR, Bit-wise AND, Bit-wise XOR
Each of these settings do similar but slightly different operations to 
the color channels. Exactly what they do is hard to explain without 
using mathematical formulas, and even then, they would not easily 
translate into a few descriptive adjectives. We suggest that you just 
try them out and see what they do. Generally, they will give very 
odd looks that reshuffle the colors through different color bands.

Alpha Threshold
Alpha Threshold defines a transparency or “alpha” for the particles 
based on the luminance value of the image used to define the 
particles. By increasing this number, less of the particle will be 
visible. The opacity of the particle will be clipped starting at the 
darker colors then transitioning to the lighter colors. It effectively 
eats away at the darker areas first and works its way to the lighter 
colors using this information to define the opacity/transparency of 
the particle image.
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Alpha Weight
Alpha Weight defines the overall opacity of the particles. Larger 
values will make the particle appear more opaque (harder to see 
through). The lower the value, the more transparent the particle 
will become.

Random Seed
Random Seed is the seed value (think of it as a start point) for any 
random values generated within the plug-in. 

TIP This is often used to reshuffle the overall look of the effect 
without changing the parameters.

Blend Original (Also just “Blend”)
Blend Original will blend in the unaffected original source layer 
with the effect. The higher this number, the more of the original 
layer will be blended in with the affected footage.

Particle System Generators

Generate From
This sets the locations the particles of the particle system will 
be created from. You can choose the particles to be generated 
from the Top or Bottom of the layer, from a point, based on the 
brightness of an image, or based on the alpha channel of an image.

Bottom/Top of Layer
Bottom of Layer will generate particles from the bottom of the 
layer to which the effect has been applied. “Top” will generate 
from the top.
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Generate Layer Alpha > Threshold
This is used to generate particles from an image that has an alpha. 
When this is selected, the particles will be generated in areas 
that are inside the alpha mask. “Generate Threshold” defines the  
area inside the alpha mask that can generate particles. When the 
“Generate Threshold” slider (below) is set to zero, all areas will 
generate particles. As this number increases, the more transparent 
areas of the alpha will no longer be able to produce particles.

TIP This is the best way to generate particles from text or a 
company logo that has an alpha channel.

Generate Layer Luminance > Threshold
“Generate Layer Luminance > Threshold” is used 
to generate particles from the lighter areas  of 
an image. The “Generate Threshold” slider (below) 
controls which areas of the image can generate 
particles. When this slider is set to zero, all 
areas of an image can generate particles. As 
the “Generate Threshold” number gets higher, 
darker areas of the image will no longer generate 
particles. The “Generate Threshold” eliminates 
potential particle-producing areas from darker 
areas up to the brighter areas. Larger threshold 
values mean only bright areas will produce 
particles.

Generate Point (Also Bubble Point, Fire Point, etc.)
This mode uses the generate point control (below) to define a point 
in the layer where the particles will be created.
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Generate Threshold
“Generate Threshold” becomes active when “Generate Layer 
Alpha > Threshold” or “Generate Layer Luminance > Threshold” is 
selected in the “Generate From” pop-up menu. When one of these 
generate methods is selected, this slider controls the level at which 
particles will be generated. When this is set to zero, any luminance 
level or alpha level can generate particles. When this is set high, 
only the brightest luminance levels or most-opaque alpha-levels will 
generate particles (i.e., this will make it so that darker or more-
transparent areas cannot generate particles).

Generate Point (Also Bubble Point, Fire Point, Snow Point, etc.)
This control becomes enabled when the “Generate From” control is 
set to “Generate from Point.” This control will set the point where 
the particles are created.

Time
This control allows you to render the effect at different times. 
This is useful for controlling the "age" of the effect. This control 
gives you the ability to make the effect generate particles at any 
point in time. 

If you did not have this ability, you would not be able to control the 
amount of particles in the effect. 
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PLUG-IN
CONTROLS  
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General
The controls always actively update the preview image. If your 
machine is too slow, turn off the preview by clicking on the red 
“preview” button. A low-resolution preview is shown first, followed 
by a higher-resolution image. The option key can be used as a 
toggle to turn the low-res preview on or off while changing a single 
parameter. You can also click to interrupt the render at any time.

Preview Window
You can drag the window around the screen by clicking and dragging 
on the “Web Euphoria” title.

You can get information about the plug-in by clicking on the 
DigiEffects logo in the lower-left corner.

Color Picker

   Use to choose colors. Click on dropper and 
   select a color anywhere on the screen (not just 

 the image area).

Popup

   Use to select a single choice or mode from a 
   list of possible modes. Click and hold to select 

 from a menu of choices.

PLUG-IN CONTROLS
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Roller
   
   Use to quickly enter numerical values. Mouse-
   down on the sphere and roll left and right to 

change values. Click on the left arrow to 
decrease value by 1 and click on the right to increase. Click on the 
white box with blue arrow to change values manually.

XY Control
   Use to select horizontal and vertical location 
   for effect parameters. Once selected, you can 
   choose the location in the preview window by 

 clicking in the image.  You can also click in 
the X and Y white boxes to change values manually.  The X and 
Y-location for the current XY-control will appear only when the XY 
control is selected. X is horizontal and Y is vertical.

Check Box
    Click to toggle(turn off and on) 
    the current setting.

Preview Controls
   Click “Preview” to turn active preview
   on and off. You can also use the option

  key to temporarily turn this feature
   on or off.
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Zooming & Panning

   Click the small mountain to zoom out, and the 
 large mountain to zoom in. 

   Click the “Hand” to pan around the image.

Presets
The little “up” and “down” arrows scroll through the presets. The 
popup gives direct access to the preset. The “+” will add the 
current parameters to a new preset, and the “-” will delete the 
current preset.

Progress
While the effect is rendering, a green bar will grow on the right 
side of the preview box. You may click at any time to interrupt 
this, and the render will resume after 1/2 second with the any new 
parameter settings. 

   Cancel
   Will cancel plug-in operation, and return 
   control back to Photoshop.

 OK
   Will apply current settings to current layer.
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Pop Ups
These menus allow you to select a single item from a list of choices.

Option Key 

By pressing this before changing any parameters, you will be able to 
turn off the low-res preview and view only what the effect will look 
like after the effect is complete.

TIP To make previews faster, here are a few tips:

1  Zoom out to less than 50%.

2  Turn preview off while adjusting multiple parameters.

3 Interrupt the preview render by clicking on another 
 parameter, or just clicking anywhere on the window.
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LIST OF TERMS

Alpha
This is an extra "channel" of information for each pixel that 
determines the "opacity" of the pixel.

Ambient
Existing or present on all sides, overall lighting.

Amplitude
Amplitude determines the height of the wave form. The higher this 
number, the more deviation from a zero value.

Bias
Bias is the weighting of one value over another. Bias gives prefer-
ence to one over the other of paired values.

Bump Map
Distortion of image base on protuberance of the surface.

Comb Mask
Simulates the color shield on a television screen.

Decay
To decrease gradually in quality and/or quantity.

Dispersion
This controls the "dissipation" of the particles. Low dispersion gives 
closer groupings and high dispersion gives wider groupings.

Frequency
Frequency determines how often the value goes up and down in 
a wave form. The higher this number, the greater the number of 
wave forms.
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Gust
A sudden brief rush of wind or an increase in the wind speed that 
occurs randomly.

Lifespan
This refers to the length of time that a particle will stay active. 
The lower the value the shorter the particle will exist.

Lilt
A springy buoyant movement, usually side to side.

Linear
Having a graph that is a line and especially a straight 
line. You will be able to expect a predictable change 
with any linear value changes.

LUT
Look-Up Table - A table of color values that corespond 
to a different set of color values.

Nodule
A small mass of rounded or irregular shape.

Phase
Phase determines frequency alignment of the waves.

Posterize
Posterizing narrows the range of colors in an image. This term is 
also known as banding.

Render
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To process the image producing a desired result.

Seed (as in Random Seed)
The initial number used as the starting point in a random number 
generating algorithm.

Sine Curve
This is the classic wave form. The graph in rectangular coordinates 
of the equation y=a sin bx where a and b are constants.

Solar Grain
Double exposed photographic paper forces the silver salts to gath-
er around areas that have contrast. This gives a “solarized” or 
“Sabbatier”. Solor Grain controls the simulated sensitivity of the 
the film which is determined by the size of the grain which gives 
a brightness pattern.

Transparency
This is essentially the same thing as Alpha. This defines the opacity 
of the pixel. When alpha is zero, the pixel is completely transpar-
ent. When the alpha is 255, the pixel is opaque.

Threshold
A level or value at which something will occur. Example, if a pixel 
has a brightness value of 128 (50% gray), a threshold value of 64 



33

would be exceeded by the 128 value of the pixel. Therefore, in the case 
of a particle system, a particle may be generated at that point. If the 
pixel value was 0 (black), then no particle would be generated.

Warp Center
Vanishing point-of-origin for the stars; or the distant heading of the 
viewer.
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AgedFilm simulates an aged “old photo look”, with grain, dust, hair, 
scratches, luminance distortion, and tinting. You can make your 
image as new or old as you want. 

If you are looking for a realistic animated film simulation, check out 
another DigiEffects product called CineLook. CineLook was designed 
to realistically simulate the look of film for video and non-film 
images.

Parameters

Film Response  This lets you control the “light gain” of the 
   image to be closer to the light response curve 
   of film.
Grain Amount  This is allows you to set the quantity of 
   graininess that you want.
Dust Size   This is the maximum size of the dust particles. 
   Smaller dust particles will be generated as well.
Dust Amount  This is the maximum number of dust particles 
   on the image.
Dust Color   This allows you to define the color of the dust.
Hair Size   This is the maximum length of your hairs on 
   the film.
Hair Amount  This is the maximum number of hairs in a single 
   frame.
Hair Color   This allows you to define the color of the hair.
Scratch Amount   This is the maximum number of scratches on 
   your film.
Scratch Velocity   Controls the horizontal speed of travel across 
   the frame for your scratches.
Scratch Lifespan  Controls how long the scratches will stay before 
   disappearing. 

AGED FILM
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Scratch Opacity  This is the maximum opacity for the scratches.
Convert to Gray Allows AgedFilm to convert the color to B&W
Gray Tint Value  The color to tint the film when “Convert to 
   Gray” is on (choose 50% gray if you do not want 
   any color added). 
Random Seed Start point for random values in the effect.
Blend   This controls the opacity of the original image 
   and the treated image. 
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Day For Night simulates the standard photographic method of 
shooting night scenes. It uses a gradient tint over the image to 
make a daylight scene look moonlit. Day for Night allows you to 
create standard film "filter" gradients, with easy access to presets.

Day for Night came to us after many many requests from users 
who had been using the CineLook day for night preset. We had an 
overwhelming bundle of requests to design a plug-in that had some 
control over the effect and was easy to use. Here it is. We think the 
presets included will handle a majority of the uses of Day for Night, 
but like all of our presets, we suggest that you use them as good 
starting points for your own experiments.

Preview LUT 
When preview is on, the source image layer is not shown. In its 
place is the gradient that is being used to create the effect. This 
can be very useful in revealing  where the position of the colors 
in the gradient are located. Alpha transparency will show as a 
checkered (black and white) region.

TIP When learning how the various  controls affect an image, turn 
this on or hold down the option key. Seeing the effect without 
the layer AND with immediate feedback makes it much easier to 
understand what is taking place when the plug-in is creating the 
Day for Night look.

Pixel Mode 
This determines how the gradient will be blended into the source  
image. By default, it is set to multiply with the Start Color black 
and the End Color white. These colors and composite mode create a 
useful starting point for the effect.

DAY FOR NIGHT
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Add
Add combines the color values of the layer with the underlying 
colors. The resulting color is lighter than the original.

Screen
Screen multiplies the inverse brightness values of the colors in all 
layers.The resulting color is never darker than the original.

Subtract
Subtract uses the effect layer to reduce the brightness of the 
original layer but does not roll over beyond zero, so the extreme 
colors do not appear and ar clipped to black.
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Difference
Difference subtracts the channel values 
of the layer and the underlying colors 
and displays the absolute value of the 
result.

Blend Using Alpha
Blend using Alpha uses the alpha’s 
weight to blend the effect with the 
original footage.
 
Multiply
Multiply multiplies the color values in 
the layers and divides the result by 255. 
The resulting color is never brighter 
than the original.

Lighter
Lighter compares the channel values of the underlying and layer 
colors and displays the lighter of the two.

Darker
Darker compares the channel values of the underlying and layer 
colors and displays the darker of the two.

Overlay
Overlay multiplies or screens the colors depending on the base 
color. Patterns or colors overlay the existing pixels while preserving 
the highlights and shadows of the base color.

Day for Night Simulation
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Hard Light
Hard Light multiplies or screens the resulting color depending on 
the original layer color. If the underlying color is lighter than 50% 
gray, the layer lightens as if it were screened. If the underlying 
color is darker than 50% gray, the layer darkens as if it were 
multiplied.

Soft Light
Soft light darkens or lightens the resulting colors, depending on 
the layer color. If the underlying color is lighter than 50% gray, 
the layer lightens. If the underlying color is darker than 50% gray, 
the layer darkens.

Minimum
Minimum uses the mathematical minimum color values to replace 
the original image. This is a modified version of Lighter.

Maximum
Maximum uses the mathematical maximum color value to replace 
the original footage. This is a modified version of Darker.

Bitwise OR, Bitwise AND, Bitwise XOR
Each of these settings do similar but slightly different operations 
to the channels. Exactly what they do is hard to explain without 
using mathematical formulas, and even then, they would not easily 
translate into a few descriptive adjectives. We suggest that you 
just try them out from time to time. Generally, they will give very 
odd looks that reshuffle the colors through different color bands.

Day for Night Simulation
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Start Color
Start Color is the first color of the gradient that is used to create 
the Day for Night Effect. This color will begin at the top of the 
layer.

Start Alpha
Start Alpha defines the transparency of the Start Color. This can be 
used to scale back or lessen the effect of the Start Color.

End Color
End Alpha defines the transparency of the End Color. This can be 
used to scale back or lessen the effect of the End Color. End Color 
is the last or bottom color of the gradient. This color will begin at 
the bottom of the layer.

End Alpha
End Alpha defines the transparency of the End Color. This can be 
used to scale back or lessen the effect of the End Color.
 
Bias
Bias defines the weight or distribution of the Start and End colors. 
The lower this number is, the more dominant the Start Color. 
Opposite with the end colors.

Blend Original
Blend Original will blend in the unaffected original layer with the 
affected layer. The higher this number, the more of the original 
layer will be blended in with the affected footage.
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Gradient Colors
These colors defines the number of additional colors that will be used 
to create the gradient color for the Day for Night effect. This pop-up 
allows for the addition of colors between the Start and End Colors up 
to a maximum of 4 additional colors (6 total including the start and 
end colors).

Gradient 1 Color
This is the color for the Filter 1 parameter.

Alpha 1
Alpha 1 controls how transparent or opaque the color will be that is 
selected under Filter 1 Color. The higher this number, the more opaque 
the color.

Filter 1 Pos
Filter 1 Pos controls the position of color one in 
the gradient that is causing the Day for Night 
Effect. It is similar to Bias for the start and end 
colors.
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This effect creates a fire effect based on the transparency or 
luminance of an image, or from the bottom, or from a point.

Fire has to be one of our most requested plug-ins of all time. This 
is probably why there are so many fire plug-ins available and even 
more tutorials on how to create fire with general purpose particle 
systems. 

The fire style is a “raging inferno” type of fire with flames flicking 
upwards from the burning object. This can make a nice torch 
burning effect. 

The fire effect is a particle based algorithm in contrast to other 
fire effects with are based on "procedural noise", like the FogBank 
plug-in. This Fire plug-in has a much more organic and realistic 
appearance due to the particle system simulation.

This will give you additional levels of fire with the same general 
look, but the various layers of fire will each have individual 
characteristics. 

TIP Sometimes blending both an organic particle based fire like this 
one with a procedural fire plug-in (use FogBank with Thermograph 
"Fire" preset) can make an even more realistic fire effect.

Image Mode
Apply Mode
Use Source Mode
Composite Mode
Particle Composite Mode
Alpha Threshold

FIRE
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Alpha Weight
Random Seed
Blend Original
Generate From
Integrate Over Time
Generate Source
Generate Threshold
Dust Point 
Time

Fire generated from alpha of source image.
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Controls in this section are described in the “Using the Plug-ins” 
section starting on page 13 of this manual. Refer to that section 
for instructions on how to use these parameters.

TIP Fire particle system and the turbulence together determine the 
character of the flames. Use these controls together to determine 
the overall look of your fire.

TIP Using the “Generate from Layer Alpha > Threshold” is the best 
way to generate fire from text or a company logo that has an alpha 
channel. See the tutorial for details.

Fire Amount
Fire Amount controls the total number of flames that are generated 
per frame.

Vert Speed
Vert Speed controls the rate at which the flames rise once they 
have been emitted.

Flame Lifetime
Flame Lifetime controls how many frames the flames will last once 
they are emitted.

Min Size
Min Size determines the smallest size flame that 
will be emitted.

Max Size
Max Size determines the largest size flame that 
will be emitted.
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NOTE Most flames will be of a size in between the Min and Max. Min and 
Max size only determine the outside boundaries of the potential size of the 
individual flames.

TIP Min size and Max size do not completely determine the size of the fire. 
Mostly they determine the style of the fire. Use fire amount to determine the 
size of the overall fire and size min and max to give the fire character.

Min Opacity
Min Opacity controls the minimal amount of how opaque the flames can be. 
When this number is set low, many of the flames will be transparent. When set 
high, you will not be able to see through the flames much at all.

Max Opacity
Max Opacity controls the maximum amount of how 
opaque the flames can be. When this is set low, you 
will be able to see through the fire to the layer to 
which Fire is applied.

Horiz Dispersion
Horiz Dispersion controls how much the flames will 
be dispersed along the horizontal axis from their 
generation location.

Wind Horiz.
Wind Horizontal controls how much sideways force 
there is on the fire.
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Wind Vert
Wind Vert gives you control over how fast the flames rise. This can 
be used in conjunction with Vert Speed to 
determine the overall flame speed.

TIP Use Vert Speed when you want the 
overall speed of the fire to stay constant 
but you need to keyframe vertically 
accelerated bursts of fire.

Turbulence 
Turbulence is the wispy appearance that is seen in the flames. 
Turbulence stretches the flames to create realism and cohesion in 
the flames.

Turb Amount
Turb Amount determines how much of an effect turbulence will 
have on the fire.

TIP The higher the Turb Amount, the slower the render. For 
Example, if this is set at 12, it will take approximately 20% longer 
than if it was set at 5.

Turb V Speed
Turbulence moves faster then the flames, that is what stretches it 
and gives it a wispy appearance. Turb V Speed determines the speed 
of the displacement field.

Turb Size
Turb Size determines the detail that is generated with the 
turbulence. The higher the number, the greater the details visible 
from the turbulence in the fire.
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NOTE We create the Fire plug-in to do one thing really well - create 
flames. But in exchange for simplicity, we left out the ability to change 
the flame color. To change the color of flames, use the built-in After 
Effects color correction tools (like HLS Balance), or use Thermograph.   

Fire generated from a single point.
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FogBank simulates a rolling bank of fog or smoke. You have full 
control over three separate banks of smoke or fog, and each bank 
can have a different seed, scale, position, blend and brightness 
value. The banks are labeled thus: Closest, Further and Furthest. 
The inspiration for this effect comes from Dan Prochazka, the 
ex-product manager for Final Effects, and the former marketing and 
sales director for DigiEffects.

The control you will be adjusting most of the time when using 
this effect is the Bank Offset control. This controls the position of 
each bank. 

Setting the bank Brightness to a lighter setting (higher number) 
will create a fog effect, and darker will create a smoke effect. 
Fog looks better for night shots, and smoke looks best for daytime 
scenes. If you would like to create an multilayered fog effect, apply 
FogBank twice, and adjust the Blend settings for each bank.

With a little bit of experimentation, you can create some amazing 
and realistic looking fog. This manual will only describe a single 
bank, as all bank controls are the same.

Parameters

Bank Blend    Controls the opacity of the bank.
Bank Brightness   Controls the brightness of the bank. 
Bank Offset   Controls the position of the bank.
Bank Seed    Controls the overall look value for the bank. 
Bank Horz Scale   Horizontal stretch of the fog bank. 
Bank Vert Scale Vertical stretch of the fog bank.

FOGBANK
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Diagram showing how layers are com-
posited to achieve effect.
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GrayScaler converts color images into grayscale images with a 
customizable luminance channel control. You can get some amazing 
looks by blending different amounts of the Red, Green and Blue 
color channels together to create a grayscale image.

Grayscaler gives control over the process of going from Color to 
Grayscale. The key here is that it allows for adding varying amounts 
of each of the red, green and blue color channels. Additionally, 
for each of these channels brightness and contrast may be worked 
with independently.

TIP When first looking at source images, it can be helpful to look at 
each of the color channels independently and without any changes 
made to the contrast or brightness of the channels. 

To do this, load each of the following presets sequentially so that 
you can see the channels: Red Neutral, Green Neutral and Blue 
Neutral. 

Weight is the amount of color that is contributed from each 
channel. The sum total of all three channels should equal 255 as 
this is the standard amount of channel contribution in a normal 
image. 

For example, It would be the same amount of luminance as a 
standard “Convert to Gray” would be in an application like Adobe 
Photoshop. If the sum total is greater than 255, it will brighten or 
“blow out” the footage (which may be an interesting effect).

GRAYSCALER
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Weight - Red/Green/Blue
Weight determines the contribution of the channel to the final 
grayscale image.

Contrast - Red/Green/Blue
Contrast controls the amount of contrast in the channel. This allows 
for increasing or decreasing the contrast levels in the channel 
before it is used in the blending of the red, green and blue channel 
to create the grayscale footage.
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Brightness - Red /Green/Blue
Brightness controls the amount of brightness in the channel. This 
allows for increasing or decreasing the brightness levels in the 
channel before it is used in the blending of the red, green and blue 
channel to create the grayscale footage.

Blend
Blend Original will blend in the unaffected original layer with the 
affected layer. The higher this number, the more of the original 
layer will be blended in with the affected footage.
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Laser creates a laser-ray style beam. You have control over the type 
of beam, the start and end point for the beam, start and end color, 
start and end size, and spacing controls. Of course, you can also 
blend with the source image.  The spacing control lets you create 
“star wars” style stun gun effects, where the beam is spaced out 
according to the spacing control.

You can control the laser type, from four types of beams. High 
Energy creates a “fat” and bright beam, Pistol creates a smaller 
beam, Thin Laser creates a very small line and Stun uses small 
ovals. The laser effect brightens the image. The colors should be set 
rather dark to keep the color saturation of the laser effect. 

If you make the color too bright, you will create a white-only laser, 
and all color will be washed out.

You can also create “blast” type explosions. To create a blast, set 
the Start and End locations close together and manipulate the Size 
controls to get the desired size and effect.

Beam Type    Controls the shape of the laser beam.
Start Point    Starting location for the laser.
Start Color    Start color for the laser.
Start Size    Starting size for the laser.
End Point    Ending location for the laser.
End Color   Ending color of the laser.
End Size    Ending size of the laser.
Use Spacing   When checked, the laser “pulses” are spaced 
   evenly  using the “spacing” control.

LASER
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Spacing    Controls the distance for the spacing of the 
   “pulses”.
Blend    This controls the overall blend of the effect 
   with the underlying layer
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LightBlast creates a zooming, misty or motion-blurred lighting 
effect. The effect can zoom towards the viewer. The source of the 
light can also be controlled, as well as the “brightness” of the 
source light.

Blast Amount  Controls the amount of zooming. The larger 
   zoom, the longer it takes to render.

Brightness   Brightness of the light source 

Light Center   Center point of the light source. Moving this 
   location will give the appearance of a light 
   moving and sending beams of light through the 
   lighted object.

Blend    This control will blend in the unaffected
   original layer with the affected layer. The 
   higher this number, the more of the original 
   layer will be blended in with the affected 
   image.

LIGHTBLAST
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Pearls creates a beautiful, flowing texture. Pearls uses a particle 
system to create its effect. You can control the number of Pearl 
Nodules (particles), the starting seed value, size of the nodules, 
brightness of the nodules, and the speed of travel of the nodules. 
You can then tint the resulting Pearl texture with a color, and also 
blend the texture with the source image. You can also execute the 
effect over the source image. Pearls is a great effect  for creating a 
texture map for use as backgrounds.

Number of Nodules  
The number of particles used to create the effect.

Tint Color 
The color to tint the texture.

Min and Max Size   
The smallest and largest size of any pearl particle.

Min and Max Brightness   
The lightest and darkest setting for any pearl particle.

Min and Max Speed Horz
The slowest and fastest horizontal speed for any pearl particle. 
Negative values move left, and positive values more right. Speed is 
in pixels per time step.

Min and Max Speed Vert
The slowest and fastest vertical speed for any  pearl particle. 
Negative values move up and positive values move down. Speed is 
in pixels per time step.

PEARLS
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Include Source   Allows you to include the source image as a part 
   of the effect.

Seed Value  The starting “random” seed.

Time    Controls the frame to render.

Blend   This control will blend in the unaffected 
   original layer with the affected layer. The 
   higher this number, the more of the original 
   layer will be blended in with the affected 
   image.



60

RainFall simulates a summer rainstorm. It automatically simulates 
the movement of rain and the individual drops can fall on the edges 
of the source image.

Rainfall is a particle system that easily and elegantly handles rain 
effects through a realistic rain simulation. You can bounce and 
splash rain off objects. The "bounce" areas can be defined using 
the alpha of the source image, or by the "luminance" of the source 
image.

You can determine where the rain will fall "from" (Generate From) 
and if the drops will splash off of anything using “Splash Via.” 

You can also control the amount, size and opacity of the droplets. 
Wind, Gravity and Gusts control the rains behavior from the time it 
falls until the time it hits something or disappears from the source 
image area. Gravity, Wind and Gusts can all have an impact on the 
path of the raindrops.

Image Mode
Apply Mode
Use Source Mode
Composite Mode
Alpha Threshold
Alpha Weight 
Random Seed
Blend Original
Preroll Frames
Generate From
Generate Layer
Generate Threshold

RAINFALL
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Generate Point
Controls in this section are described in the “Using the Plug-ins” 
section starting on page 13 of this manual. Refer to that section for 
instructions on how to use these parameters.

Splash Mode
Splash Mode determines if and how the rain drops will splash in 
the footage.

 Don’t Splash
 When selected, there will be no splashing of the rain drops 
 anywhere in the footage.
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Splash On Bottom
When selected, Splash on Bottom will make the rain drops splash as 
they hit the bottom of the layer to which the effect is applied.

Splash on Alpha > Threshold via Vert Height 
This will cause the rain to splash on the first vertical pixel IN THE 
ALPHA CHANNEL detected. The threshold control will determine 
which pixels in the alpha channel will be detected as the first pixel 
to pile up on. a means alpha. 

Splash on RGB > Threshold via Vert Height
This will cause the rain to splash on the first vertical pixel in the 
image detected. The threshold control will determine which pixels 
in the image will be detected as the first pixel to splash on. 

Splash on Alpha > Threshold via 2D
Splash on RGB > Threshold via 2D creates a mask that works in all 
directions to define areas of the layer where the rain will splash.
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Splash Threshold
This defines the minimum value for a pixel in order for a droplet to 
splash on the source image or “Splash Via Layer” image.

Rain Generate
Rain Generate determines how much rain will fall (be generated) per 
time step. This could be considered the volume control.

Min Size
Min Size determines the smallest possible size for a rain drop.

Max Size
Max Size determines the largest possible size for a rain drop.

NOTE Min Size and Max size are the outer limits for the size of the rain 
drops. The drops will be a size in between these extremes.

Min Opacity
Min Opacity determines the amount of transparency that the drops can 
have. The lower this number, the more transparent or see through.



Max Opacity
Max Opacity determines how opaque (non-see through) that the rain drops 
can be.

Wind, Gravity, Gusts 

Wind creates movement within the rain drops. Gusts 
interject chaotic movement increasing the realism of
the simulation.

Gravity
Gravity determines how fast the rain will fall. The 
higher this number, the faster the raindrops will fall and 
become longer due to motion blur applied to the rain 
drops.

Wind Horiz
Wind Horiz determines the speed at which the rain 
drops will move to the sides. When this number is 
positive, the rain will fall from left to right. When the 
numbers are negative, the rain will fall from right to 
left.

Wind Vert
Wind Vert increases or decreases the vertical speed of the rainfall. This can be 
used to increase the initial speed which in many cases starts at zero.

NOTE Gusts are blasts of wind that move the rain horizontally for short periods 
of time.



Gust Probability
Gust Probability determines the likelihood of a gust occurring at any 
given time.

Gust Max Duration
Gust Max Duration determines how long the gusts will last once they 
do occur.

Gust Max Speed
Gust Max Speed determines how far the gust will move the raindrops 
horizontally.
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Retinal Bloom simulates an all-over lens-flare effect. It is primarily 
designed for night-time scenes, but can be used for day scenes. 
You have full control over the shape of the “bloom” or lens iris 
shape, the size of the bloom, the threshold for the blooming, the 
brightness of the bloom, the amount of blur and the amount to 
blend with the original image.

Due to the nature of the processing for this effect, render times 
can be rather long for large and bright images. Zoom out while 
experimenting with settings for faster previews.

Threshold Min and Max
Brightness value or sensitivity for the effect to apply 
the bloom shape.  Lower = darker parts of the image 
and higher = brighter parts. 

Size Min and Max 
These set the limits for the random sizes of the 
blooms.

Use Single Color 
When checked, the effect will use the color in the "Single Color" for 
the color of the blooms.

Single Color 
This is the Picker for choosing a color if the Use Single Color box 
is checked.

RETINAL BLOOM
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Angle Min and Max 
These set the limits of random displacement angles between the source 
image and blooms.

Trans Min and Max  
The upper and lower levels of the bloom transparencies. higher number = 
more opacity and lower numbers = more transparency
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Quality
Low  Gives a low resolution preview.
Normal Gives a medium level effect.
High  Gives a per-pixel effect, can be slow.

Effect Only
When this box is checked the rendered image will contain only the 
effect and no source image.

Bloom Shape
Determines the shape of the effect.

Effect Only - Based on luminance. Min Threshold = 250, Max = 255



69

Soft & Bright   Oval    Hexagonal

Rounded   Star

Min Threshold = 250, Max = 255
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Sabbatier is a photographic process simulation for creating the look 
of double exposed photographic paper that forces the silver salts 
to gather around areas that have contrast. This gives a “solarized” 
or “Sabbatier” look.

TIP Slide the Contrast and Rotate sliders (especially Rotate) back 
and forth and you will find a setting that works well with your 
image.

Invert   Applies the Sabbatier effect to the layer after 
   the layer to which the effect has been applied 
   has been inverted (i.e., dark pixels become 
   light and light pixels become dark in the
   inversion process - then the solarize effect is 
   applied).
Rotate  Rotate controls the appearance of the solarizing 
   effect. Sabbatier can have drastically different
   appearances that are defined by the subject 
   matter. Work with this control to define the 
   basic look that is being created.
Contrast   This adjusts the tonal range of the image before 
   the Sabbatier Effect is applied. When these 
   numbers are high, the difference between light
   and dark becomes exaggerated. Small (between  
   5 and 35) amounts of contrast will often 
   enhance the solarize effect.
Solar Grain   This feature adds a filmic grain pattern to
   the image.

SABBATIER
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NOTE If you have a portion of the image that appears to be 
posterizing after applying the Sabbatier effect, it is probably from 
the grain settings. Try turning the grain to zero and see if the 
posterization is still visible.

Blend Original  Will blend in the unaffected original layer with 
   the affected layer. The higher this number, the 
   more of the original layer will be blended in 
   with the affected footage. 
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This effect allows you to add posterization (also known as color 
banding) of an image through the Red, Green and Blue channels 
independently.

Since the concepts are the same for Red, Green, Blue and Alpha 
channel controls, we will describe the controls once.

Red, Green, or Blue Levels
   Controls the number of levels within the 
   selected channel.

Use Red, Green, or Blue Channel
   This toggle alows you to turn off or on the 
   selected channel.

Blend   This will blend in the unaffected original layer 
   with the affected layer. The higher this 
   number, the more of the original layer will be 
   blended in with the affected footage.

Tied To The Red Green and Blue channels use the same
   values as the red channel.

SELECTIVE

POSTERIZE
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Shadow Type allows you use the Shadow and Glow features in a very 
simple and easy to control environment.

Font   You can choose from any fonts that you have 
   loaded in the System Folder:Fonts folder.

Font Hue  Allows shifting of the chosen color either left 
   or right on the spectrum. This will make sense 
   as soon as you try it.

Font Color  Choose the font's color with the dropper tool.

Font Lightness Controls the amount of white in the color.

Font Saturation Determines the font's color intensity.

Font Leading Leading is the distance between two lines of 
   text (separated by "returns".)

Font Size  Adjusts the font's size in 1 point increments.

Font Spacing  Controls the distance between letters. Also 
   known as kerning.

Font Style  Allows for bolding, italisizing, or both. If both 
   boxes are unchecked, font is regular.

Text Location This tool can either place the font via the 
   cursor or with x & y coordinates.

SHADOW TYPE
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Shadow Color Choose the shadow's color with the dropper
   tool.
Shadow Saturation Determines the shadow's color intensity.
Shadow Lightness Controls the amount of white in the color.
Shadow Offset This tool can either place the shadow via the 
   cursor or with x & y coordinates.
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This effect generates smoke from a point, the bottom of a 
layer, or an alpha channel.

Tip When previewing the effect, let the render finish before making 
changes to your settings. The final effect will be slightly different 
than during the preview render.

NOTE See the front section for a detail explanation of the smoke 
creation parameters.

Smoke Amount 
Sets the total smoke of the rendered effect.

Vert Speed  
Vertical speed of smoke, higher = faster upward.
   
Horiz. Dispersion 
Varies the starting location and horizontal speed.

Wind Horiz. and Vert.
Controls direction of wind's effect on the smoke.

Apply Mode  
Composite with the source, or use effect only.

Use Source Mode 
Controls compositing mode

Composite Mode 
If “Use Source Mode” is a composite mode, this is the procedure 

SMOKE
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used to composite the effect and source images.

Alpha Threshold 
This sets the threshold for the alpha 
of the source image.

Alpha Weight 
This is the compositing weight for 
the overall effect.

Generate From 



78

Chooses how the particle system will generate.

Min and Max Opacity
Sets limits on the darkest and lightest smoke.

Generate Threshold
Simple threshold to control generate layer -higher numbers = 
brighter values.

Smoke Point  
Point from which particle will eminate , if using Point Generate 
mode.

Smoke Color  
Controls tinting of the smoke via 
dropper.

Color Variation
Allows for changing tint within a 
selected range.

Random Seed 
Creates similar but different looks.
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Blend    This control will blend in the unaffected
   original layer with the affected layer. The 
   higher this number, the more of the original 
   layer will be blended in with the affected 
   image.

Time   How much the particle system will run before 
   rendering final image.

Generating smoke from the alpha  Smoke from a point.
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Snow Storm creates a realistic simulation of a winter storm with 
complete control. It also simulates gusts of wind and you can have 
the flakes land and stick to a logo.

Snow Storm is another of the particle systems that handles a single 
task very well and very easily. If you just let the default settings 
render with Effect Only selected in Apply Mode, you will see a 
beautiful example of what the snow plug-in can do.

The snow plug-in has been designed so that the snow drifts in a 
particular direction, but also includes a great deal of semi-chaotic 
motion.

The Snow particle system determines the quantity, size, distribution 
and other behaviors for the individual snow flakes. The Wind, 
Gravity, Lilt area controls the characteristics of the overall 
direction and fall pattern of the snow flakes.

Image Mode 
Apply Mode
Use Source Mode
Composite Mode
Alpha Threshold
Alpha Weight
Random Seed
Blend With Original
Generate From
Integrate Over Time  
Generate Layer
Generate Threshold
Snow Point
Controls in this section are described in the “Using the Plug-ins” 
section starting on page 13 of this manual. Refer to that section 

SNOW STORM
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for instructions on how to use these 
parameters.

Pile Up Mode
Don’t Pile Up
When selected, Don’t Pile Up will allow 
the snow to disappear as it hits the 
bottom of the layer.

Pile Up On Bottom
When selected, Pile Up On Bottom will 
stick and pile up as it hits the bottom of 
the layer.
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Pile Up on Alpha > Threshold via Vert Height
This will cause the snow to pile up on the first vertical pixel IN THE ALPHA 
CHANNEL detected. The threshold control will determine the minimum opacity 
of a pixel in the alpha channel to pile up on.

Pile on RGB > Threshold via Vert Height
This will cause the snow to pileup on the first vertical pixel in the image 
detected. The threshold control will determine the minimum brightness level of 
the pixels in the image as the first pixel to pile up on.

Pile on Alpha > Threshold via 2D
Pile on RGB > Threshold via 2D creates a mask that works in all directions to 
define areas of the layer that snow will stick and pile-up over. 

Pile Up Threshold
Threshold cuts off the darker parts as areas that the snow can pile upon. The 
higher this number is set, the lighter the pixels must be to allow the snow 
to pile up.

NOTE The objects (mask or pixels) that the snow falls onto cannot be moving. 
If it is, the snow buildup information will become confused. The snow will not 
stick to moving objects.

Time
This control allows for the start of the effect before the first frame of the 
clip. This control is designed to give you the ability to have the effect already 
generating snow before the clip shows. If you did not have this ability, the 
effect would have to start with no snow. By pre-rolling, you can have the 
effect already generating snow from the first frame in the layer. The value 
corresponds to the number of frames before the first frame that the effect 
starts generating the snow.
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Snow Generate
Snow Generate determines how many snow particles will be created 
per time step.

Min Size
Min Size determines the size of the smallest flakes created by the Snow 
plug-in.

Max Size
Max Size determines the size of the largest flakes created by the Snow 
plug-in.

Min Opacity
Min Opacity determines the most transparent any part of any flake can 
be.

Max Opacity
Max Opacity determines the most opaque any part of any flake can be.

Lilt, Gravity, Wind, Gusts 
Lilt is the random motion that individual snow flakes have. While snow 
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tends to fall all in a single direction, the individual flakes have 
a chaotic motion that allows them to move randomly - sometime 
with the general direction of the snow, sometimes against it. This 
individual flake motion is defined as lilt. While this is a global 
setting, it is applied to each flake individually. A random number 
between the min and max amounts will be picked and applied to 
each flake.

Min Lilt Amount
Min Lilt Amount determines the minimal distance that the lilt will 
move the flake.

Max Lilt Amount
Max Lilt Amount determines the maximum distance that the lilt will 
move the flake.

Min Lilt Frequency
Min Lilt Frequency determines the minimum speed at which the 
snow flake will move due to the lilt.

Max Lilt Frequency
Max Lilt Frequency determines the maximum speed at which the 
snow flake will move due to the lilt.

NOTE Amount determines how far, frequency determines how fast.

Gravity
Gravity determines how quickly the snow will fall. The higher this is 
set, the faster that the snow will fall.

Wind Horiz.
Wind Horiz determines how much horizontal push can be applied to 
the snow to give the appearance of horizontal wind.
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Wind Vert
Wind Vert increases or decreases the vertical 
speed of the snow. This can be used to increase 
the initial speed which in many cases starts at 
zero.

Gust: A gust is a sudden brief rushing or driving 
of wind.

Gust Probability
Gust Probability defines the likelihood that a 
gust of wind will occur at any given time in the 
composition.

Gust Max Duration
Gust Max Duration determines the greatest 
number of frames that a gust can last. 

NOTE This does not dictate a fixed number of frames that all gusts will 
last. It only determines the maximum amount of time that it can last.

Gust Max Speed
Gust Max Speed determines the maximum amount that the gust can push 
the snow when a gust does occur.
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Specular Lighting simulates a single colored light source shining on 
the image as if it were a piece of plastic.

The effect's light source can simply shine on the surface, or you 
can automatically create a bump-map of the source image. Then,  
the plug-in will simulate hills and valleys over the image. You can 
control the smoothness and depth of the “bumpiness”. Control the 
surface look is done via the Materials sliders. These will determine 
the Ambient, Specular, Highlight, and Diffuse Lighting parameters. 
These control how the surface material interacts with the light 
source. You can make the surface look glossy, flat, or anything 
in-between.

Light Type   Determines the Light modeling mode:
 Point Light   Light comes from a point close to the surface.
 Directional  Light is reflected at an angle from a light 
     source infinitely far away.
Light Color  Determines the color of the light source.
Light Intensity Controls the overall brightness level of the light 
     source.
Position Height Determines the height of the light source above 
     the surface of the image.
Position X  Defines the horizontal light location.
Position Y  Determines the vertical light location.
Direction Height Determines the outward direction of the light.

Direction X  Determines the horizontal direction of the light.

Direction Y  Determines the vertical direction of the light.

SPECULAR LIGHTING
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Material Diffuse This controls the diffuse light reflection 
   amount.

Material Ambient This controls the ambient light reflection 
   amount.
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Bump Map Style To apply a bumpy-looking surface to the image, 
select a bump map type other than “None”. The different shapes 
curve the surface differently.

None  No bump map applied.

Linear  Slanted.
 
Logarithmic A plateau look.
 
Sine  Smoothly curving, straight in the middle.
 
Spherical Completely smoothly curved, 
   no straight lines.
 

NOTE These settings must be experimented with, as they are 
difficult to describe succinctly with words.

Bumpmap Depth Determines the “deepness” of the bump-map 
   effect.

Bumpmap Smoothness
   Determines the “softness” of the bump-map 
   effect.

Blend   This control will blend in the unaffected
   original layer with the affected layer. The 
   higher this number, the more of the original 
   layer will be blended in with the affected 
   image.
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Spherical Bump map style.

Weird looks are available.
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StarField creates a simulation of flying through a field of stars. You 
have full control over the number of stars, speed, warp center, 
perspective, streak amount, distant cutoff, maximum size, random 
color, color stars, minimum and maximum color for the stars, and 
blending with the original image. Increase the streak amount for 
“star wars” light-speed jump effects. 

Hint: For a more convincing effect, render a single frame with no 
streaks and lots of stars. Use this single frame as a background for 
the star speed effect.

Number of Stars Controls the total number of stars in the image.

Streak Amount   This controls the length of the streaks of the 
   stars.

Star Shape    Shape of the star to render. Use single dot to 
   speed up rendering.

Speed   The speed controls how fast you travel through 
   space. 

Time    Controls the render location in time.

Warp Center  The warp center controls the point where the 
    stars will eminate.

Minimum/Maximum Size
   This controls the minimum and maximum size 
   of the stars.

STARFIELD
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Birth Fade Up   Controls the num. of frames to fade-up new 
   stars. Bigger=slower.

Random Seed Creates similar but different looks.

Star Color  The color range of the stars. 

Blend   This will blend in the unaffected original layer 
   with the affected layer. The higher this 
   number, the more of the original layer will be 
   blended in with the affected footage.
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Thermograph is an extremely flexible color remapping effect. The 
basic idea is that you can take any color in the image and replace it 
with any other color based on a color gradient.

When in Preview Mode, the gradient on the left is the source colors. 
The gradient on the right is the colors that will be replace the 
source colors.

In other words, the colors in the source layer are represented by 
the gradients on the left, and these colors are all replaced by the 
colors in the gradients on the right.

Preview LUT  (Look Up Table) provides the ability to look at 
   the colors that will be used to replace the 
   existing colors in the image.
   When this is checked on, the colors will be 
   shown along with Red, Green, Blue and Gray 
   color ramps so that it is possible to judge what 
   color will be replaced with the LUT color.

Gradient Mode Controls the interpolation method used   
   between the gradient color positions.
   Linear  Straight line interpolation.
   Curved Smooth curving.
   Sine Wave Repeating pattern.
   Circle-
      Increasing Half interpolated.

Gradient Color This determines the color of the location 
   within the gradient.

THERMOGRAPH
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Gradient Position  Determines the position of the Gradient color 
   on the gradient relative to the Start Color and 
   End Color.

TIP  A good way to see the results of this is to set this to red and 
slide the control left and right. Notice that as you approach 100% 
that the bottom or end color of the gradient gives a very hard red 
line. This is how bias works. As you get to 100%, the entire interior 
of the layer turns red. 

This is because you have completely removed the End Color. As 
additional gradient colors are selected in the Multigradient pop-up, 
the Gradients 2 to 10 controls are made functional. Each of these 
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works in the same manner as the Gradient 1 controls with each 
additional color being added at their respective positions in the 
gradient.

Pixel Mode  
This allows for the application of the thermograph effect to a single 
channel only or to all three (RGB) at once.

Color Mode 
Defines how the colors are interpolated. RGB Modes interpolate 
along a straight line using the Red, Green and Blue channels. HSB 
modes interpolate through the colors as if they were a rainbow.

Start Color 
Defines the color that will replace the darkest colors in the footage.

End Color 
Defines the color that will replace the brightest colors in the 
footage.

Multi-Gradient
This pop-up determines how many colors will be in the gradient. 
The colors will always fall in between the start and end colors. 
For Example, S ->1 ->E, will provide for a 3 color gradient starting 
with the start color, transitioning to the Grad 1 Color and ending 
with the End Color.

Bias 
Controls the balance of color or the quantity of color between the 



95

start and end colors in the gradient. When this is shifted to the 
right, the end color will be more dominant in the gradient, when 
it is shifted to the left, the start color will be more dominant.

Blend 
This will blend in the unaffected original 
layer with the affected layer. The higher this    
number, the more of the original layer will be    
blended in with the affected footage.
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VideoLook simulates TV interference and video screen snow. This 
is a great filter for music videos, games, and creating interesting 
looks for video art. Gets you that ultra-grungy, deconstructed, 
dirty, future-technology  look. Use it for video phones, interstellar 
transmissions, infrared goggles, and anywhere you need a cheap 
video look. 

Even and Odd  The filter uses two alternating scan lines (even 
   and odd). The two lines are controlled 
   independently.
Brightness   Controls the brightness of the line.
Size    Controls the size of the line's thickness.
Noise    This allows you to set the quantity of 
   graininess that you want.
Distortion   Horizontal offset distortion, for sine-wave or 
   random line offsets.
Blend    Blends back in with source image. Great for 
   reducing the distortion.
Gray Tint Color   Determines the color to tint the line if 
   converted to gray.
Comb Mask    Set the kind of “comb” or horizontal skipping 
   of pixels.
Decay Amount  Controls the amount of decay or number 
   of times that the effect repeats itself. 
   You will want to experiment with this.
Colorize Noise Creates colored snow.
Distortion Mode

Shift   Shifts the line to the left or right.
Linear  Moves it left or right on the diagonal.
Noisy   Shifts left and right by a random 
      amount per line.
Sawtooth  Similar to linear, shifts left or right, 
      then snaps  back.
Wave   Does a sine-wave horizontal distortion.

VIDEOLOOK
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Alternate Dist. Uses a different, smoother look.
Gray Convert   Controls whether or not the line should be 
   converted to gray.
Time Vary Par. This changes the look of the distortions.
Blend   This will blend in the unaffected original layer 
   with the affected layer. The higher this 
   number, the more of the original layer will be 
   blended in with the affected footage.
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Visual Harmonizer creates stunning geometrical images based on 
a series of sine waves which are rendered as particles or as 
illuminated lines.

Each of these harmonizer shapes are controlled by the frequency 
(how close together the waves occur), amplitude (how high each 
wave will go) and phase (determines the position of the peaks and 
valleys of the waves in the Harmonizers.)

Keyframe the start and end controls for each of these settings 
to determine moving wave patterns and experiment with differing 
numbers for the start and end values.

This effect was inspired by Nick Philip, nphilip@best.com, 
http://www.best.com/~nphilip/astrisk/

Image Mode 
Apply Mode
Use Source Mode
Image Composite Mode
Particle Composite Mode
Blend Original
Alpha Threshold
Alpha Weight
Controls in this section are described in the “Using the Plug-ins” 
section starting on page 13 of this manual. Refer to that section for 
instructions on how to use these parameters.

VISUAL HARMONIZER
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Number of Frequencies
Number of Harmonizers defines how many bars are created with 
the Visual Harmonizer. The more Harmonizers created, the slower 
the render.

Particle Shape
Particle Shape defines the basic look or appearance of the bars 
created with Visual Harmonizer. Each of these particle shapes gives 
a significantly different look, especially when Use Spacing (below) 
is checked on.
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Start Point / End Point
These points define the left side and right side of the effect.

TIP If you want the Harmonizer to run top to bottom instead of side 
to side, use Effect Only in the Apply Mode pop up. Then rotate the 
Rotation control under the Transform menu.
NOTE The Transform controls are available within Photoshop. 

Start Color
Start Color is the color of the first frequency or wave.

End Color
End Color is the color of the last frequency.

Start Size
Start Size is the thickness of the first or start frequency.

End Size
End Size is the thickness of the last frequency. Each of the 
frequencies in between will vary in width in a linear manner 
between the start and end size.

Start Opacity
Start Opacity determines the transparency or opacity of the first 
frequency.

End Opacity
End Opacity determines the transparency or opacity of the first 
frequency.
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Start Amplitude
Start Amplitude determines the height of the first frequency. 

End Amplitude
End Amplitude determines the height of the last frequency.

NOTE Load the preset Simple Waves. Notice that the start and end 
amplitudes are different and that that is generating variations on the 
height of the frequencies. Also note that while start amplitude is set to 
zero, there are still waves in the harmonizer.

Start Frequency
Start Frequency determines how often the start 
frequency goes up and down in a wave form. The 
higher this number, the greater the number of wave 
forms.

End Frequency
End Frequency determines how often the end frequency goes up and 
down in a wave form.
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Start Phase
Start Phase determines the alignment of the 
waves of the first frequency.

End Phase
End Phase determines the alignment of the waves of the last 
frequency.

Use Spacing
When this is checked, Use Spacing breaks the frequencies from solid 
lines into individual dots (depending on the Particle Shape).

Spacing Distance
Spacing Distance is only valid when the Use Spacing box is checked. 
When it is checked, this determines the amount of space between the 
individual particles that make up the frequencies.

Spacing Phase
Spacing Phase determines the location of the particles that make 
up the frequencies.
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FAQ'S, TIPS, 
AND SUPPORT
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Frequently Asked Questions

MEMORY REQUIREMENTS
All of Web Euphoria's effects must render within the RAM space 
of Photoshop and are intended for web-sized and digital camera 
images. Some effects require 2-3 times the amount of RAM used by 
the layer that the effect is being applied to. 

If you have low memory error messages, please increase the 
memory partition for Photoshop by 5,000K each time you receive 
out of memory messages. The recommended partition size for 
Photoshop is 64mb (64,000K) for web-based images. We recommend 
at least 256mb (256,000K) for print documents, but this may not 
be enough for some documents. You will need to quit Photoshop to 
change this setting.

Most effects are limited to use on images that are less than 2000 x 
2000 pixels. Most of the images on the internet are much smaller 
than that though. If your document is larger, apply the effect to 
a smaller section that is less than 2000 x 2000 in pixels using the 
selection tools.

Use the “Piggy Plug-ins Patch” if you keep receiving out-of-
memory messages. The “Piggy Plug-in” will allow more memory 
from Photoshop to be used by the plug-ins. This plug-in can be 
found on the original Photoshop installer CD, please do a search. 

Photoshop automatically reserves more than 80% of the memory 
space to itself during start-up. This memory is not available for 
use by the Web Euphoria plug-ins. The "Piggy Plug-in" alleviates this 
problem by allowing a little more memory to be available for use by 
the Web Euphoria plug-ins.
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PROBLEMS WITH INSTALLATION

The most common problem with installation is that the plug-ins do 
not show up.  First, be sure that the plug-ins are indeed in your 
“plug-ins” folder.  If they are and still don't appear, it is because 
Photoshop does not always check to see if there are new plug-ins 
in the “Plug-ins” folder every time Photoshop is launched. This is 
done  to make launching Photoshop faster.  To fix this you need to 
force Photoshop to look at the plug-ins folder for new plug-ins.  To 
do this, tell Photoshop the plug-ins folder is in a different place, 
then switch it back.  The steps seem a bit crazy, but this is the 
way it goes. 

1 Launch Photoshop.
2 Open the File Menu > Preferences > Plug-ins dialog.
3 Set the plug-ins folder to any other folder outside the 
 Photoshop folder. 
 IMPORTANT: Do NOT choose a folder inside the Photoshop 
 folder. Click OK.
4 Quit Photoshop and then immediately Launch Photoshop 
 again.
5 Open the File Menu > Preferences > Plug-ins dialog.
6 Set the plug-ins folder back to the normal plug-ins folder, 
 which is usually in the same folder as Photoshop.
7 Quit Photoshop, and then Launch Photoshop again. The plug-
 ins should now appear.
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Trouble Shooting

• How can I make Web Euphoria render faster?
1) Reduce any “Smoothness” parameter to the lowest possible setting.
2) Adjust parameter when zoomed out.

• I can’t find Web Euphoria in the Effects menu.
Be sure that you installed the filter into the correct plug-ins folder. It should be 
in the same folder as your copy of the Photoshop application.

• I can’t apply a Web Euphoria effect to a layer.
Be sure Web Euphoria is installed, and you have the layer selected before 
applying the filter. If it asks for your Master CD, insert it in your CD-ROM drive.

• I keep getting out of memory messages.
Increase the memory partition for Photoshop, or reduce the size of the images 
you are using, or reduce the quality draft mode.

• I’d like to see a faster preview.
You can drop the resolution by clicking on the mountains in the preview window. 
By doing this you can increase preview speeds by up to 800%. This is useful to see 
to overall effect quickly, or to try out animated parameter settings. Grain will 
look different, but all other aspects are previewable.

• I’d like to see real-time previews of the effect.
Hold down the option key while moving any slider.

• I can’t run the filter on my computer.
You will need a PowerPC, G3 or better with at least 128mb of RAM applied to 
Photoshop.

• Web Euphoria is asking for the Master CD!
You must keep the master CD in the drive the first time you use a Euphoria
plug-in. After that you do not need to use the Web Euphoria Master CD. The 
Master CD acts like a hardware key and authorizes you to use the software.
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Tips and Tricks

Visual Harmonizer

1. First tip is this, animating the PHASE controls is essential to getting this 
plug-in going. Moving the sine waves OUT OF PHASE means having the START 
PHASE and END PHASE moving in opposite directions and I think this can look 
very dynamic.

2. One of my favorite features of this plug-in is the ability to animate a particle 
over the sine waves. Pick PARTICLE SHAPE: DOT and check the box labeled USE 
SPACING. You VH-1 types will undoubtedly love this feature as it will make nice 
layers in your motion graphics work. Try using *huge* STARTING SIZE and ENDING 
SIZE and varying the PARTICLE COMPOSITE MODES. (I like Screen & Blend) 

Then you’ll see SPACING PHASE and SPACING DISTANCE parameters. These are 
the main controls for making these DOTS move. Leaving the PHASE of the sine 
waves fairly slow, try animating the SPACING PHASE parameters to get the dots 
rolling. I

3. I was really excited when I found large particles look really cool with the right 
spacing and composite mode. Try using only 3-6 waves with large particles moving 
slow. If you set the frequency and amplitude just right you can create something 
which resembles a winding dna strand. The plug-in can create interesting 3D like 
twisting images which wave and twist like landscapes from dreams.

4. Some particle composite modes can really give the illusion of 3 dimensionality. 
I found that the Rings particle and Multiply particle composites look very 3d. 
When you animate with these settings the results can have a beautiful feel with 
3d textural flavor.
 
Smoke

1. Generally speaking smoke is a very layered phenomenon and I’ve said it before 
so I’ll say it again: using multiple layers and instances of plug-ins give you the 
most realism. Since smoke in nature is a dynamic turbulent system, its important 
for those who want natural looking smoke to approach creating it this way. 
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Although the DigiEffects Smoke plug-in is one of the best plug-ins available for 
creating smoke effects, you should try to use at least two instances of it to create 
the illusion of nature.

2. In addition to using multiple layers, I’ve found that the most natural looking 
smoke also has a kind of edge density phenomenon which can be approximated 
by employing the AE plug-in Find Edges combined with gaussian Blur. If you use 
blur then find edges(check invert box in Find Edges) in duplicates of a layer and 
use transfer functions and layer opacity you will find that the smoke takes on 
a new type of look. 

Something a bit more like the long tendrils of a smoldering cigarette. Be sure that 
within the smoke plug-in that “EFFECT ONLY” is activated  as the APPLY MODE. 
(see first parameter) This will make multiple instances composite a little better 
when using certain transfer modes.

3. Another trick I like to use involves duplicating a layer multiple times and then 
editing the smoke on each layer using different RANDOM SEEDS. When you change 
the random seed number, the way the smoke is generated varies in that instance 
of the plug-in. What I like about this feature is that you can basically start with 
all of the parameters exactly matching. When you vary a small amount in each 
layer and use transfer modes to blend the layers together, you get a very nice 
interaction between the individual layers. 
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Troubleshooting & Support

Most questions we receive are easily found in the 
documentation. Please read it all the way through and your 
question will probably be answered. 

But, if we’ve over-looked something, or you have found a reproducible crashing 
error, the fastest way to find out is to check the web site for a possible updated 
version or workaround (FAQ on site: www.digieffects.com)

After that please feel free to contact us at the following addresses... ; )

Please have this information available for us when you send the message:
1 Machine Model                                                     
2 Processor speed (Mhz)                                                     
3 Processor Type                                                     
4 Operating System (Mac/Windows)                                                  
5 Operating system version                                                   
6 Amount of installed RAM                                                   
7 Application you’re using                                                    
  (Photoshop, ImageReady, etc.) 
8 Amount Mem. applied to Application                                                  
  (if applicable), 
9 Amount of hard disk space                                                   
10 Your Name, Company & Phone Num.                                                  

e-Mail [This is the best way to get a thorough answer]
 support@digieffects.com

world wide web [BEST CHOICE]
 www.digieffects.com

fax • phone
 512.306.1310 fax • 512.306.0779
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